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Introduction
Preliminary topics:
Capabilities
General Procedure
Types of Windows

1.1

Capabilities

CRYSCON is a general crystallographic conversion program, with the followingcapabilities. See
General Procedure for an overview of the main possibilities.
1) Data Entry. Data can be imported from several popular crystallographic file formats, read in
through a "free-form" file input, or entered manually.
2) Tranformation of unit cell and atomic coordinates. You can convert to a sub-cell or supercell or simply translate to a different origin; or any combination of these. When converting to a
sub-cell the positions of presumably coincident or superimposed atoms are averaged, and when
converting to a super-cell the extra symmetry-unique atoms which may be required are generated.
In any case the result is a set of symmetry-unique atoms for the target cell and symmetry, suitable
for entry into crystallographic software such as Fourier analysis, least-squares refinement or
structure drawing (Control Window, Transformation Parameters dialog).
3) Change of symmetry in the same or different unit cells. You can convert to a sub- or supersymmetry group, or even a non-related space group. As in the case of cell transformation, new
atoms are generated and/or old atoms are averaged as necessary, and the result is a set of
symmetry-unique atoms for the target cell and symmetry (Control Window,
Transformation Parameters dialog).
4) Transformation of anisotropic temperature factors and atomic vectors (e.g. magnetic
vectors).
5) Computation of bond lengths and angles in either the original or transformed structures
(Bond Lengths and Angles).
6) Conversion of temperature factors among the different common isotropic and anisotropic
forms (Export file).
7) Conversion of atomic parameters among several different crystallographic database and
structure refinement formats (Export file).
8) Transformation of hkl index data, such as diffraction data (Transformation Parameters
dialog).
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9) Computation of powder diffraction intensitities and simulation of powder diffractograms
(Powder Diffraction).
10) Simulation of precession photographs (Precession Pattern).
11) Expansion of layers, leaving the layers themselvesunchanged, creating space in between
(Expand Layers).

1.2

General Procedure

The first step is to enter or import the data for the crystal to be transformed. To import from one
of several file formats, choose Import from the File menu. After selecting the format, you will
see the Import File dialog. The 3-letter file extension ".xxx" in the edit box will be used to filter
the files (that is, the Open File dialog will show only the files with this extension). Any changes
you make in file extensions will be saved for future runs. Some formats may offer a choice of
symmetry option; if the file actually lists symmetry "as XYZ", that is in the form of the positions
of the general equipoint for the space group in the International Tables for X-ray
Crystallography.
To enter the data manually, choose New from the File menu.
In the first dialog which appears, Title/Axes, supply an 80-character title, and specify the unit-cell
parameters.
The two Symmetry options are Space Group and Custom. The Space Group option lists almost
all standard orientations and origins, so this is usually the first choice. You can type in a
Hermann-Maughin or Hall symbol, or give the International Tables number, but it is normally
safest to select the space group in the scrolling list and double-click on it or click the Select
button (be sure the symbols/number for the selected group appears in the edit boxes above). If
you type in the H-M symbol, it is interpreted either according to Volume I of the 1952 edition of
the International Tables , or Volume A of the 1983 edition. The main difference between the two
is that in Volume I the default orientation for monoclinic crystals is a-axis unique, and in Volume
A the default is b-axis unique. That is, if you type in "P2/m" the orientation will be different. Of
course to be certain you can also type in the long form "P112/m" or "P12/m1", or select one of
these in the list.
If the space group is a non-standard one, such as C-1 (Cbar1), it will be necessary to use the
Custom Symmetry option. Often you can start with the Space Group option and then switch to the
Custom option (Change Symmetry Option button) and make modifications as necessary. In the
list of operations you must supply (if they are not there already), the coordinates of the equivalent
positions of the general equipoint as listed in the International Tables , one per line. If the space
group is centrosymmetric and the origin is on a center of inversion, select the Centric radio
button and supply only half the operations – the center will be supplied by CRYSCON. If the
origin is not on a center of inversion, you must supply all the operations and select the Acentric
radio button.
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In the Input Atom (Site) dialog, supply the standard atomic parameters. The type is normally the
atomic number, but it could also be an arbitrary number. If there is only one occupant of the site
or position it is not necessary to enter the data in the list box. If there is multiple occupancy, click
on Add and supply the parameters as necessary in the Atom Sharing a Site dialog. For a
cell/symmetry tranformation such multiple occupancies are seldom used - they are simply carried
over for possible Export. The label and type of the main entry will be those of the first occupant.
When the atom list is complete you are done with the "Old" crystal. The atom list is shown in the
Control Window. You can save this file or document at any time with the Save or SaveAs
options in the File menu.
General Procedure for Cell/Symmetry Tranformation
Now click on the Transform button to specify the parameters of the "New" crystal. In the
Tranformation Parameters dialog, click on the Symmetry button if the symmetry of the New
crystal is to be different from the old symmetry. Specify the symmetry as above. The symmetry
specified here pertains to the New orientation, not the Old. The default symmetry is the same as
the Old.
Three types of transformation can be carried out - Translation only, Input atoms only, and Full
unit cells. Input atoms only is the only option which will transform anisotropic temperature
factors and/or atomic vectors (magnetic, displacement, etc.). See Tranformation Parameters for
more details.
The parameters specified in the Tranformation Parameters dialog, going downward in the dialog,
correspond to the operations successively carried out by CRYSCON.
First, translations may be applied to the input atom coordinates (Pre-symmetry translations). If
the origin for your atom coordinates does not correspond to that of the standard symmetry
specified for the Old crystal, corrections must be made here. If you select Translation only , this
is all that will be done – the remainder of the parameters are ignored.
Input atoms only option:
CRYSCON applies the Pre-matrix translations, transforms the coordinates of the Old input
atoms only, and applies the Post-matrix translations. (Pre-symmetry translations are not
used). This gives a set of input atoms for the New structure, and the tranformation is complete.
Anisotropic temperature factors and atomic vectors are transformed to the new unit cell.
Full unit cells option:
CRYSCON now generates all the atoms in the Old unit cell. If the origin of the New unit cell
differs from that of the Old, with respect to the common symmetry elements, you must make
corrections in the Pre-matrix translations edit boxes. Such differences among sub/supergroups
are common, and it may be necessary to study the diagrams and coordinates in the International
Tables to get these translations.
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CRYSCON now transforms the coordinates according to the matrix supplied. Now it has the
contents of the Old unit cell, expressed in coordinates of the New unit cell.
In order to fill out the contents of a supercell, or to shift the contents for a reorientation,
CRYSCON now systematically adds and subtracts the New unit-cell vectors.
Next, in order to average atom positions for a subcell or an increase in symmetry, CRYSCON
similarly adds and subtracts the Old unit-cell vectors. If the position of a new atom generated in
this way falls within the specified distance, or Tolerance, the atomic positions are averaged.
CRYSCON keeps a running count of the number of atoms averaged in this way. The tolerance
should be large enough to avoid having quasi-superimposed atoms in the result, but of course it
must be less than the smallest bond length in the structure. Setting this may take some trial and
error. A value of 0.4-0.5 seems to be large enough for even rather extreme cases of atomic shifts
in sub/supercells and sub/supergroups.
Post-matrix translations may be applied here if the standard origin for the New space group is
different from that of the Old space group. This is an alternative to the Pre-matrix translations it should not be necessary to use both.
At this point, there should be a complete and hopefully realistic set of atoms for the New unit cell.
Depending on the symmetry change, the new set may or may not conform to the New symmetry.
CRYSCON now applies the New symmetry to eliminate symmetry-equivalentatoms. Again a
tolerance is applied to decide if atom positions are "coincident". This generates a standard set of
symmetry-unique atoms, or the "asymmetric unit". However, in many cases when generating a
subcell or increasing the symmetry the averaging process does not put the new atoms exactly on
special symmetry positions.
CRYSCON now applies the new symmetry to the supposed asymmetric unit, to generate a
complete set of atoms for the New unit cell. You should know, based on simple volume
considerations, how many total atoms are expected in the New unit cell. If the number of atoms in
the unit cell generated in this step does not agree with that generated by transformation (before
symmetry consolidation), CRYSCON now prints out the number it has generated and asks if you
want to recycle to refine the location of atoms on special positions. If the atoms in special
positions were not located within tolerance (.0001??) in the previous step, extra atoms will be
generated, and the total generated will be greater than expected. If so, "recycling" will repeat the
previous step of reducing to the asymmetric unit, and hopefully averaging will place the atom
positions closer to the symmetry elements, if not on them (within tolerance). It may take several
cycles of no change in number before the number of atoms generated comes down to the number
expected. If there appears to be no improvement after 3 or 4 cycles, inspection of the results is in
order - the correction to the atoms in special positions may be obvious, or it may appear that the
matrix and/or translations are not valid.
When you decline another cycle, the process is terminated and the results appear in a special
Output Text or Edit window (see Types of Windows). This window has a separate menu bar,
with standard entries for text editing. This text document or output file can be saved separately
from the input data (which is in files with extension .cco) using the Save and SaveAs option in
this menu bar.
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Note that when different input atoms are consolidated during a transformation, for example superto sub-cell or on increasing the symmetry, CRYSCON does not attempt to combine the two sets of
occupancies; it simply takes the list of occupants from the first atom generated.
In the Full unit cells option, CRYSCON does not attempt to transform anisotropic temperature
factors; if there are anisotropic temperature factors they are converted to isotropic B's in the New
structure. Atomic vectors are not transformed either - the New atoms will have vectors which are
simply copied from the first Old input atom which was used to generate the New atom.
To go back to the main data input, click on the Control Window or use the Window menu to
switch. The process or tranformation can be repeated without removing the Output window, but
its contents will be replaced. If you want to save successive results files, use the SaveAs option
(when the Ouput file is active or has the focus) to give the file a different name (eg myfile1.ccd)
before recalculating.
The transformed (New) input atoms (symmetry-unique atoms) can be converted into the original
(Old) input atoms with the Transformed to Input option in the Input menu.
Other Operations
There are several things which can be done without Transformation. All these operations may be
done on the transformed atoms, as well as the original atoms, after a transformation has been
carried out.
Bond Lengths and Angles. The Bond Lengths and Angles button in the Control Window will
call up a special dialog for this.
Powder and Precession diffraction simulation. See the Powder Diffraction and
Precession Pattern dialogs.
Exporting Files. You can write files containing either the Old data or the New data in most of
the same format as are available for import. Select Export in the File menu. In the case of input
files for structure refinement programs, such as SHELX, RIETAN, DBWS/LHPM, etc.
CRYSCON cannot supply all of the required parameters, only the symmetry, unit cell and atomic
positions and temperature factors. Non-essential information such as comments is also not
necessarily passed on, but in most cases the relevant lines can simply be copied from the import
file (Old crystal) to the export file (New Crystal).

1.3

Types of Windows used in CRYSCON

CRYSCON uses four types of windows besides dialogs and alerts; the Startup window, the
Control window, Text windows and Graphics windows. In Windows, each window has its own
menus; in Macintosh, the menus are at the top of the screen. The menus and commands therein
depend on which type of window is active.
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When starting up CRYSCON, the menus displayed include only a File menu and a standard Help
menu. Use the commands in the File menu or the buttons in the window itself to start a new
CRYSCON data set, or read an old one from a file.
After you have entered or read in the data for a CRYSCON file, the Control Window opens. This
is actually a kind of dialog, but it cannot be dismissed without closing the current data set. Only
one data set at a time is allowed in CRYSCON, and there is only one Control Window. When this
window is active, the File Menu has additional commands such as Export, the View Menu has
Powder Diffraction and Precession Pattern options and there is an Input Menu for data input and
modification. Note that the Print, Print Preview and Metafile options in the File menu are inactive
- they are active only when a Graphics window (below) is active.
The Transform button in the Tranformation Parameters dialog lists the transformed atom
parameters and other data to a separate Text window. The Listing option in the
Powder Diffraction dialog ( File Menu) lists the data to a Text window, as does the
Bond Lengths and Angles dialog (called from the Control Window). When any of these Text
windows is active, the menu bar contains standard menus for saving, printing and editing the
contents. Each window actually displays the contents of a file, called respectively Powder1.dat,
Powder2.dat and BONDS.DAT. These files are written over again each time the respective
option is called, so if they are to be preserved they should be saved with the Save As command in
the File Menu, using a different name.
The Powder Diffraction and Precession Pattern dialogs (Diffraction Menu) present output in
Graphics Windows. When a Graphics menu has the focus, the Print, Print Preview, Raster and
Metafile or PICT options in the File Menu produce graphics output, essentially what is shown on
the screen. There are four possible Graphics Windows, for Powder Pattern Old and New atoms,
and Precession Pattern Old and New atoms.

2

Menus and Dialogs
Startup Window Menus
Control Window Menus
Text Window Menus
Diffractogram Windows

2.1

Startup Window

Startup Window (see Types of Windows).

This window appears when CRYSCON is first started, or when a data set
(Control Window) is closed.
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It has its own menu bar, and the following buttons for getting a data file into CRYSCON.
New - Step-by-step input of a new CRYSCON data set.
Open - Open an old CRYSCON data file.
Import File - Shows a pop-up menu with the file types currently supported. This
includes:
---- CCDC FDAT files from the Cambridge Crystallographic Data Centre.
---- SHELX .INS files from the program system of Prof. G. Sheldrick.
---- CIF - Crystallographic Information Files.
---- DBWS/LHPM Rietveld input files.
---- ICSD Inorganic Crystal Structure Database files.
---- ORTEP Original or ORTEP II atom information.
---- XTLVIEW Drawing program.
---- VIBRAT (.MOT) Graphic output files from VIBRATZ.
---- PDB Protein Data Bank files.
---- RIETAN Rietveld program files.
---- GSAS Data files (.EXP) files from the Los Alamos Lab system - may include
magnetic vectors.
---- AM MINERAL. Data files from the American Mineralogist structure data base.
---- FULLPROF. All-purpose refinement program - may include magnetic vectors.
---- Free-form (.inp). This allows input of atomic coordinates and other information
from almost any source.
Exit/Quit - Quit the CRYSCON program.
2.1.1

File Menu - Startup Window

New - Step-by-step input of a new CRYSCON data set.
Open

- Open an old CRYSCON data file.

Close

- Close the current graphics window.

Save

- Save a CRYSCON data file.

Save as

- Save a CRYSCON data file with a new name

Import File - Shows a pop-up menu with the file types currently supported. This includes:
--Free-form (.inp) This allows input of atomic coordinates and other information from almost
any source.
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--CCDC FDAT files from the Cambridge Crystallographic Data Centre.
--SHELX .INS files from the program system of Prof. G. Sheldrick.
--CIF - Crystallographic Information Files.
--DBWS/LHPM Rietveld files.
--ICSD Inorganic Crystal Structure Database files.
--ORTEP Original or ORTEP II atom information.
--XTLVIEW Drawing program.
--RIETAN Rietveld program files.
--GSAS Data files (.EXP) files from the Los Alamos Lab system - may include magnetic
vectors.
--AM MINERAL Data files from the American Mineralogist structure data base.
--FULLPROF . All-purpose refinement program - may include magnetic vectors.
--ATOMS Atomic structure plotting program (Shape Software).
--VIBRATZ Normal-coordinate calculation program for crystals and molecules (Shape
Software).
Quit - Quit CRYSCON.

2.1.1.1 Import Data File
Dialog Box: Import File

[ File Menu ]

If there is a data set in memory which has been modified, you are asked if you want to save the
changes.
If there is more than one data set or phase in the file, the Data Sets...in Import File dialog will
present you with a list. The name of the CRYSCON data file will be taken from the name of the
file, and the title ( Control Window or Title/Axes dialog in the Input Menu) will be taken from the
data set or phase. The extension .CCO will be appended to the structure file.
File Extension. The three-letter extension (.XXX) which identifies the file type under Windows
may be specified here - only files of that type will be shown in the Open File dialog. To show all
files, enter ".* ".
Source of symmetry (some formats lack this option). If you select Use positions as xyz, in
which symmetry operators are given in the form of positions in the general equipoint as in the
International Tables , the symmetry option (Input Menu) will be Custom Symmetry. After
import, you may need to check the Symmetry option to be sure the centric/acentric choice and the
Bravais lattice type are correct (some formats include a center of inversion and/or lattice
centerings in the operators and some do not). If you select Space group symbol, the
Space Group symmetry option will be used. The Hall symbol, the Hermann-Maughin symbol,
and then the International Tables number will be used in that order if present. If you select Use
positions as xyz and the information on operations is not present, the symmetry option will default
to Space group symbol. The H-M space-group symbol, Hall symbol, and space-group number
are always read if present.
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If symmetry is present in the "xyz" or operation form, this is usually the safest option However,
this option does not give information on systematic extinctions or true d-spacings, which are
required for the Powder and Precession options. It is usually possible to derive the correct spacegroup symbols from the operations using the Get Symbol option in the Custom Symmetry dialog.
Atom types (some formats lack this option). If a distinct atom type number is not present in the
input, CRYSCON will try to assign an atomic number to each input atom either from the first one
or two characters of the atom label itself, or from a separate atom type label if that is present. In
diffraction refinement file formats, this separate atom type label typically identifies the scattering
factor, and it may be a matter of operator preference whether this or the atom label (if either) will
identify the element.
Note that in the case of multiple atoms with the same coordinates, that is multiple occupancies for
a site, CRYSCON consolidates them into one input atom, but preserves the information on the site
occupants (see Input Atoms).
File types supported, with the default extension:
**** Free-Form - .inp. This imports files in the free-form format described elsewhere (
Atom Parameter Files ). Note that this format has been expanded, so that essentially all relevant
data for a crystal may be entered.
**** CCDC (Cambridge Crystallographic Data Centre) FDAT - .fdt. The files normally
contain a unique set of input atoms, which are the same as those required for input of a crystal in
CRYSCON, plus in many cases some extra symmetry-derived atoms necessary to complete the
molecule; CRYSCON will use only the unique set of atoms, omitting the extra ones.
**** SHELX-93 - .ins. CRYSCON is programmed only for SHELX-93 files, although it may
also be possible to read SHELX-76 files.
Symmetry . The Custom Symmetry option will be used. Typically the true space-group symbol
can be recovered from the title. CRYSCON will read the SYMM lines in the SHELX file only if
they are in standard International Tables format - the translational part must precede the
positional part (i.e. 1/2+x, not x+1/2). If the symmetry was copied from the Tables , there should
be no problem. You can edit the symmetry operators after they are read in.
FRAG instruction . Atoms listed between this instruction and the FEND instruction will be
ignored.
RESI instruction . Atoms listed after this instruction will be included, but not treated in any
special way.
Hydrogen atoms . SHELX has several sophisticated ways of locating hydrogen atoms which are
not duplicated by CRYSCON. Frequently, the positions of the hydrogen atoms are not in the
.INS file, and must be taken from the output. The output lines giving the hydrogen positions can
be copied into the .INS file. If this is done, a type or SFAC number must be inserted after the
label and before the coordinates. The hydrogen lines can also be put into a separate file and read
in with the SHELX +filename include-fileinstruction.
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Most of the instructions in a SHELX file will be ignored. However, CRYSCON may not know
all the current instructions. If it cannot identify an instruction, it tries to read the line as an atom
line (this is the way SHELX works). If this fails, you are asked if you want to add the first four
letters of the line to the list of instructions to be ignored. These instructions-to-be-ignoredare at
the end of the SCRPTR setup file, separated by spaces and preceeded by the number of
instructions. You can edit this list if necessary.
**** CIF (Crystallographic Information Files) - .exp. CRYSCON uses only a small number
of the possible data items in a CIF file and recovers only the most basic information. The
dictionary file, CIFDIC.SHT (a shortened version of the complete CIF dictionary), must be in the
home directory (the directory containing the CRYSCON.EXE file).
**** DBWS/LHPM Rietveld - .dbw/.lhp. The DBWS and LHPM formats are very similar.
In the Atom type numbers from: box, the Type label option will select the NTYP field which
usually contains the elemental symbol for recovery of the scattering factor.
Three different versions of DBWS file are recognized: 9002, 9411 and 9807. Trying to read a
9002 file may cause an error on the first pass, as CRYSCON tries to read according to the later
formats, and in that case you will have another chance to read again according to the 9002 format.
Files with only one phase are more likely to be read correctly (but please report any problems
reading valid DBWS files).
**** ICSD ( Inorganic Crystal Structure Database) - .ret/.cry. Three types of ICSD file are
supported:
1) Files from the current CD-ROM database, accessed by the program RETRIEVE. The
RETRIEVE files must be written from the DATA window using the PRINT option, not as export
files (if there is sufficient demand, export files may be supported). That is, the file should be a
copy of what is shown on the screen in the RETRIEVE program.
2) Files from the Canadian Scientific Numeric Database System (CAN/SND). This service may
no longer be available. The files are referred to as CRYSTIN.
3) Files in the original CRYSTIN format (or close to it), available from the Netherlands CAOS
information system, from ETH (Switzerland) and perhaps other sources. These files are also
referred to as CRYSTIN.
Please contact Shape Software if you have ICSD files which cannot be read by one of these
options. The best procedure is to send samples of the files by email or an a floppy diskette.
In CAN/SND files, CRYSCON will use the "NA:" line for the title; in RETRIEVE and original
CRYSTIN files, CRYSCON will use the first "MINR" line if present, otherwise it will use the
"NAME" line.
**** ORTEP - .ort. This imports the unit-cell parameters, symmetry, atomic positions and
thermal data from original or ORTEP II files. It does not read the boundary and plotting
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instructions.
**** XTLVIEW - .xtl. CRYSCON may need to shift the fractional coordinates to insure that
the origin is placed on a center of inversion.
**** FULLPROF - .exp. The "User-supplied" non-magnetic and magnetic options (JBT = +-4
or +-5) are not directly supported - crystallographic and magnetic parameters in files using these
options will be read as if one of the standard options were used. Magnetic information is always
read as vectors in the crystallographic axes (not as polar or other coordinates), and FULLPROFspecific magnetic symmetry is not currently used.
**** American Mineralogist Structure Database - .amc. The American Mineralogist structure
database is currently available on the Internet at www.geo.arizona.edu/xtal-cgi.test. This may
change, but the database should be locatable by searching for American Mineralogist.
**** GSAS - .exp. The General Structure Analysis System (Los Alamos) can give magnetic
moment vectors.
**** RIETAN - .xyz. This format gives complete symmetry operations, including a center of
inversion and lattice centerings if present, as numeric matrices. CRYSCON will convert the
matrices to "xyz" form and use the Custom Symmetry option. It will also attempt to identify the
center of inversion and lattice centerings and will remove them with your approval.
**** ATOMS (Shape Software) - .str. CRYSCON will read and store data on atom colors and
radii from these files. Such data will be written into free-form (.inp) files when exported, and can
then be read back into ATOMS.
**** VIBRATZ (Shape Software) - .vbr. CRYSCON will read the main data files (.vbr) from
the Windows version.

2.1.1.2 Data Sets in Import File
Dialog Box: Data Sets...in Import File [ Import File Command - File Menu ]
When you open an Import File, CRYSCON will search through it to find all the data sets within
it, up to a limit. If there is more than one data set, this dialog will present you with a list. The
name of the CRYSCON data file will be taken from the name of the file, and the title
(Control Window, or Title/Axes dialog in the Input Menu) will be taken from the data set, phase
or crystal selected. The extension .cco will be appended to the structure file.

2.2

Control Window

This window, which has controls like a dialog, is present whenever a data set is in memory. It
lists the input atoms and allows easy modification of them and access to the main operations in
CRYSCON.
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The Symmetry button allows specification or modification of the current symmetry for the
original or old atoms - it calls up the Symmetry dialog, if an option has not been selected, and
either the Space Group Symmetry or Custom Symmetry dialogs if the option has been selected.
The Transform button brings up the Transformation Parameters dialog, which allows
specification of the parameters for the new crystal. The unit-cell and atomic coordinates of the
new crystal are displayed in an output text window which is called from the
Transformation Parameters dialog. If you want to carry out certain operations on the old crystal
only, such as Export ( File menu), Powder Diffraction or Precession Patterns (Diffraction Menu
menu), it is not necessary to Transform.
The Expand Layers button brings up the Expand Layers dialog - this will expand a crystal
structure on certain planes, increasing the length of the selected axis, but leaving the actual shortrange dimensions of most of the structure (bonds, etc. within layers) unchanged.
The New to Old button will replace the current Old or input atoms, cell and symmetry with the
the New or transformed atoms, cell and symmetry. You will have the option of saving the current
file and assigning a new name to the transformed data.
The large list window gives the current Old or original input atoms, which can be modified or
deleted with the buttons below the list. Atoms can also be modified by double-clickingon the
selection, which brings up the Input Atom (Site) dialog.
CRYSCON lists only distinct atomic positions, or sites, in this dialog. These sites may have
multiple occupants, which are listed in the Input Atom (Site) dialog. The site occupancy (SOF)
for each input atom shown in this dialog is the sum of the individual occupancies, which can be
accessed through the Input Atom (Site) and Atom Sharing a Site dialogs.
B(equivalent) is equal to Biso or derived from Uiso if the site is isotropic, or calculated according
to the formula below for anisotropic sites.
Beq = 2pi^2 (1/3) Sum(i) Sum(j) U(ij) a*(i) a*(j) A(i) A(j)
where a*'s are the reciprocal axis lengths and A's are the direct axis lengths.
The Bond Lengths/Angles button brings up a dialog allowing calculation of bond lengths and
angles for all atoms or a selected atom - you can choose either the old or new crystal.

2.2.1

Input Atom (Site)

Dialog Box: Input Atom (Site) [ Control Window ]
Label. Each atom may be assigned a label of up to 6 characters. Labels in CRYSCON may not
contain any embedded blanks. Any embedded blanks or leading blanks in labels in import files
will be converted to underscores. Trailing blanks will be stripped.
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Fractional coordinates. For crystals, the x , y and z coordinates should be in fractions of the
unit cell.
Type. It is usually expedient to enter the same type for all atoms which are bonded similarly (e.g.
all carbons, all silicons, all six-coordinated cations, all oxygens, etc.) to save effort in defining
bonds and polyhedra. The atomic number can usually be used for the type, although there are
situations in which different type numbers should be used for the same element.
In a transformation, if atoms are found to be superimposed the type and other parameters are
simply taken from the initial atom generated in this position. Thus if it is known that atoms are
going to be consolidated, for example in a super- to sub-cell transformation, it may be a good idea
to use a single type for those which will be consolidated.
Any change in the Label or Type for the site will be transmitted to the first site occupant.
The list box gives the current occupants of the site. To modify individual occupants, double click
on the selection or click the Revise button.
In the Temperature Factor group, the type number as used in ORTEP must be specified. The
temperature factors are given below (in abbreviated form). The common type numbers are given
in the dialog; other types are rarely used nowadays. Supply the b, B or U double-subscripted
coefficients as required - in type 0, the b coefficients are usually called betas. If the type is
isotropic, the single value (B or U) is given in the (11) box.
ORTEP Types of Temperature Factors
Type 0 - e^(-b11h^2...+2b12hk...) *** Beta aniso
Type 1 - e^(-b11h^2...+b12hk...)
Type 2 - 2^(-b11h^2...+2b12hk...)
Type 3 - 2^(-b11h^2...+b12hk...)
Type 4 - e^(-.25(a*^2B11h^2...+2a*b*B12hk...)) *** B aniso
Type 5 - e^(-.25(a*^2B11h^2...+a*b*B12hk...))
Type 6 - ISOTROPIC - e^(-B(sin(theta)/lambda)^2) *** B iso
Type 7 - sphere of arbitrary radius
Type 8 - e^(-2pi^2(a*^2U11h^2...+2a*b*U12hk...)) *** U aniso
Type 9 - e^(-2pi^2(a*^2U11h^2...+a*b*U12hk...))
Type 10 - ISOTROPIC - e^(-2pi^2U(sin(theta)/lambda)^2) *** U iso (not a standard ORTEP
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type)

2.2.2

Atom Sharing a Site

Dialog Box: Atom Sharing a Site

[ Input Atom (Site) dialog ]

This lists the properties for each occupant of a site.
Site occupancies in CRYSCON do not include space-group multiplicities and the total for a fullyoccupied site should be 1.0. If Import or Export files include multiplicities CRYSCON should
convert as necessary.
The Type and Site Occupancy will be used in the intensity calculations for Powder or Precession
patterns. For this purpose, the type number should be a valid atomic number, unless the
SCATFAC.DAT file (containing the scattering factors) is modified.
Any change in the Label or Type of the first occupant will be transmitted to the main entry for
the site in the Input Atom (Site) dialog.
The Element, Charge and Scattering Number are parameters specific to some import/export file
types, and are not used by CRYSCON. They may not be meaningful unless the data is exported
in the same format in which it was imported.

2.2.3

Bond Lengths and Angles

Dialog Box: Bond Lengths and Angles

[ Control Window ]

This supplies the parameters for the computation of the list of bond or interatomic distances and
angles centered on one or all of the input atoms. You can select either original (Old) or
transformed (New) atoms. The radio buttons determine whether distances and angles are
computed for all input atoms or only the one currently selected in the Control Window or in the
edit box.
Only 36 atoms in addition to the central atom are allowed, so the distance limit for centralligand should normally not be more than about 4 Angstroms. Angles are only calculated for
ligand pairs at less then the ligand-ligand limit; if you want to determine angles for atoms on
opposite sides of the central atom, the ligand-ligand limit should be twice the central-ligand limit.
The results of the distance and angle calculations are written to a file called either Bonds1.ccd
(original atoms) or Bonds2.ccd (transformed atoms) in the home directory (see
Files used by CRYSCON), and then shown in a Text window (see Types of Windows ). This
window has its own menus for editing and saving the text file. From this Text window, return to
the Control window and the ordinary operating mode of CRYSCON by clicking in the Control
Window, or with the Window menu.
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Errors in bond lengths and angles are not calculated by CRYSCON. This is because sufficient
data are seldom available for accurate calculation - it would be necessary to have the complete
variance-covariance matrices for both the unit-cell and atomic-parameter refinements. The
difference between the correct error values and those calculated using only the standard deviations
of the parameters is usually not large, but discrepancies between values in the original
publications and those calculated by CRYSCON could create confusion.

2.2.4

Expand Layers

Dialog Box: Expand Layers

[ Control Window ]

This option will expand a crystal structure on certain planes, increasing the length of the selected
axis, but leaving the actual short-range dimensions of most of the structure (bonds, etc. within
layers) unchanged. It operates on input atoms (original crystal), leaving the symmetry unchanged.
Any atoms which are exactly on the expansion plane (for example K atoms in a mica structure)
will remain on the expansion plane, and thus bonds from these atoms to other parts of the
structure will be lengthened. Bonds connecting structural layers will also be lengthened.
The Expansion factor is the amount by which the selected axis is increased. For example, if the
c-axis is 10.0 Angstroms before conversion, an expansion factor of 1.5 will change it to 15.0
Angstroms.
Expand on axis. This selects the axis to be lengthened. Fractional coordinates of most atoms on
this axis will be changed. The other two axes, and fractional coordinates on these axes, will be
unchanged.
Number of planes. There are often several symmetrically identical planes cutting the selected
axis. For example, there may be identical mirror planes at 0.0 and 0.5. You must determine this
number from examination of the space-group symmetry.
Expand at zero. There may be a choice of location of the expansion planes. Normally this will
be a choice between the set of planes at fractional coordinate zero (on the expanded axis) and
another set at some rational fractions. For example, if the Number of planes is 2, there may be a
set at 0.0 and 0.5 and another at 0.25 and 0.75. If the Expand at zero box is checked, the
expansion will be at the first set.
At the moment an arbitrary location of the expansion plane is not supported, and for lowsymmetry crystals, or those which have a choice of more than two locations, it may be necessary
to adjust all coordinates so that the expansion plane is at zero. If this situation is common,
support for arbitrary location will be added.
Tolerance. This is used to decide if an atom is exactly on the expansion plane, in which case its
coordinate on the expansion axis will not be changed - that is, it will remain exactly on this plane.
Tolerance is in fractional coordinate units (not Angstroms). If you want atoms which are exactly
on the expansion plane to remain in continuity with the remainder of the structure, their fractional
coordinates on the expansion axis should be changed by greater than the tolerance. Usually this

© 2002 Shape Software

20

CRYSCON Help

will result in duplication of the atoms.

2.2.5

File Menu - Control Window

New - Step-by-step input of a new CRYSCON data set.
Open

- Open an old CRYSCON data file.

Close

- Close the current graphics window.

Save

- Save a CRYSCON data file.

Save as

- Save a CRYSCON data file with a new name

Import File - Shows a pop-up menu with the file types currently supported. This includes:
--Free-form (.inp) This allows input of atomic coordinates and other information from almost
any source.
--CCDC FDAT files from the Cambridge Crystallographic Data Centre.
--SHELX .INS files from the program system of Prof. G. Sheldrick.
--CIF - Crystallographic Information Files.
--DBWS/LHPM Rietveld files.
--ICSD Inorganic Crystal Structure Database files.
--ORTEP Original or ORTEP II atom information.
--XTLVIEW Drawing program.
--RIETAN Rietveld program files.
--GSAS Data files (.EXP) files from the Los Alamos Lab system - may include magnetic
vectors.
--AM MINERAL Data files from the American Mineralogist structure data base.
--FULLPROF . All-purpose refinement program - may include magnetic vectors.
--ATOMS Atomic structure plotting program (Shape Software).
--VIBRATZ Normal-coordinate calculation program for crystals and molecules (Shape
Software).
Export File - This will write unit-cell, symmetry and atomic-coordinate information in most of
the Import formats above.
Quit

- Quit CRYSCON.

2.2.5.1 Export Data File
Dialog Box: Export Data File

[ File Menu ]

You have the choice of exporting the original (Old) or transformed (New) data. Note that the
transformed data is not otherwise saved except in the .ccd file which is written on transformation,
although it can be recalculated easily enough.
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Most of the import/export formats supported by CRYSCON fall into one of two categories;
archival formats and refinement formats. The archival formats, such as CIF, ICSD and CCDC
tend to give only basic crystallographic information, including space group, unit cell parameters,
atomic coordinates and thermal parameters. The refinement file formats, such as DBWF, SHELX
and GSAS generally contain much more information, such as scattering factors, weighting factors
and refinement flags. CRYSCON generally cannot provide all this latter information, and it
cannot be expected that a refinement-format file written by CRYSCON will be successfully read
in by the target refinement program (e.g. DBWF, SHELX or GSAS) without many additions and
even some editing of the lines which are written by CRYSCON, since even these lines may contain
some refinement-specific data.
Space groups symbols may be written in many ways, for example space group number 116: P4c2; P -4 c 2; P_-4_c_2; P4-c2. CRYSCON does not generally change the symbol - it is usually
exported in the form it was imported or entered. The SgInfo routines used by CRYSCON can
interpret many of the variations, but export target program may not be able to interpret some
forms, and it may be necessary to edit the space group symbol after exporting a file.
You can convert the type of the temperature factors, e.g. from beta's to U's; and/or you can
convert from isotropic to anisotropic and vice versa. Of course not all export formats allow a
choice. If the Keep current form radio button is checked, the current temperature factors will be
kept, if possible . However, the export format may not support the current form, in which case
the temperature factors will be converted to a type which is supported.
The equivalent isotropic temperature factor, if converting from anisotropic to isotropic, will be
computed according to the formula:
Beq = 2pi^2 (1/3) Sum(i) Sum(j) U(ij) a*(i) a*(j) A(i) A(j) where a*'s are the reciprocal axis
lengths and A's are the direct axis lengths.
If the Remove multiple occupancies box is checked, only a single atom will be written for each
site, using the relevant data for the first atom in the list of occupants. If not, in most file formats a
new atom will be written for each site occupant - that is, the number of atoms in the export file
will be larger than the number of sites listed by CRYSCON.
Note that when different input atoms are consolidated during a transformation, for example superto sub-cell, CRYSCON does not attempt to combine the two sets of occupancies; it simply takes
the list of occupants from the first atom generated.

2.2.6

Input Menu

Title/Axes - Input of the 80-character title, selection of crystal system and specification of unitcell parameters
Symmetry - Selection of space-group or custom symmetry
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2.2.6.1 Title/Axes
Dialog Box: Title/Axes [ Input Menu ]
The title may have up to 80 characters of identifying information.
You should supply the axis lengths and interaxial angles appropriate to the crystal system you
selected. Axis lengths should be in Angstroms, and angles in degrees and fractions (not minutes
and seconds).
Although standard crystallographic nomenclature gives the same letter (usually a) to symmetryequivalent axes, after the initial input CRYSCON may call all axes, whatever the system, "a, b,
and c" and angles "Alpha", "Beta" and "Gamma".

2.2.6.2 Symmetry
Dialog Box: Symmetry [ Input Menu - Control Window - Transform Dialog ]
The authority and source of information for crystal symmetry is normally the International
Tables for X-ray Crystallography . However, any space-group symmetry may be used for the
atoms. There are two options for selecting or entering symmetry information.
Space group from table

- Choose a space group by symbol or number.

Custom Symmetry (xyz) - Enter all the individual operations as fractional x,y,z coordinates in
the unit cell.
Each choice calls up a sub-dialog.

2.2.6.2.1 Space-Group Symmetry
Dialog Box: Space Group Symmetry from Table [ Symmetry dialog ]
Space-group symmetry is obtained using licensed excerpts from the SGInfo program of Ralf
Grosse-Kunstleve.
You can specify the space group in any of three ways: 1) the Hermann-Maughin (H-M) or
International symbol; 2) the Hall symbol (S.R. Hall: Acta Cryst., A37, 517, 1981); or 3) the
number of the group in the International Tables for X-ray Crystallography .
International Tables Volume. You have the option of using the older version of the Tables
(called the Second Edition : various revisions and reprints from 1952 to 1979) in which the
symmetry information was in Volume I, or the newer version (1983 onwards) in which it is in
Volume A. The principal difference between the two versions is that in the older one the unique
axis of a monoclinic group is assumed to be the c-axis, whereas in the newer one it is assumed to
be the b-axis. Thus entering the symbol P2/m gives two different orientations depending on the
volume selected. You can always specify the orientation by entering the long form of the symbol,
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i.e. P 2/m 1 1, P 1 2/m 1 or P 1 1 2/m.
The H-M or Hall symbol can be typed into the appropriate edit box in either short form or long
form, with or without spaces between positions. However, it is usually safer to select the symbol
from the list box at the bottom, which gives the standard-form symbols for all the space-groups.
Clicking the Select button copies the relevant data to the edit boxes at the top; it does not actually
generate the symmetry. Symmetry generation is done after you click OK - this may take a few
seconds.
If the space group you select does not appear to be consistent with your choice of axes, a warning
box appears, but in most cases consistency is not required. However, if you selected trigonal
rhombohedral axes in the Title/Axes dialog, only a rhombohedral space group may be selected.
This is done by adding :R to the end of the symbol in the case of H-M symbols, or asterisk (*) in
the case of Hall symbols. If you select the rhombohedral setting and then switch to the
Custom Symmetry option, the lattice type will be P; it will be R if the axes are hexagonal.
Origin of coordinates. In the International Tables , 24 space groups in the orthorhombic,
tetragonal and cubic systems are given with a choice of origin: 1) not on a center of inversion or 2)
on a center of inversion. These two origins are selected by adding :1 or :2 respectively to the end
of the H-M symbol or the number. Although the origin on the center is second in the Tables and
in the list, if the number is omitted this will be the default. This difference in origin is explicit in
the Hall symbol, and other choices of origin may be specified for any space group with the Hall
symbol. Note also that the origin may be shifted before transformation (see
Transformation Parameters).

2.2.6.2.2 Custom Symmetry
Dialog Box: Custom Symmetry [ Symmetry Dialog ]
CRYSCON can access all the standard orientations for space groups in the International Tables
but there are still a few possibilities for alternate settings of symmetry elements with respect to
structure axes which are not listed in the Tables . In some cases displacement, rotation or
permutation of atomic coordinates may not be convenient, and it may be easier to enter the
symmetry operations for the non-standard setting. These are sometimes given in reports on
structures (e.g. Wyckoff, Crystal Structures ). Note however that often only the operations for
special positions are given: CRYSCON needs all the operations for the general position.
Some Import formats do not give a space-group symbol, and symmetry is supplied in the form of
operations as xyz, or as actual numerical matrices. CRYSCON converts numerical matrices to
xyz form.
The Symbol is not used by CRYSCON for transformations, unless you switch to the
Space Group Symmetry option. However, the Powder and Precession options require a valid
space-group symbol - they must use the symmetry from the symbol rather than the custom
symmetry.
Get Space Group Symbol. This button will attempt to identify the space group from the
operations, the lattice type and the centric/acentric setting. If the operations contain an inversion
center or lattice centerings, CRYSCON should identify them and they can be removed at your
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option. Clicking the Change Symmetry Option button will automatically causes an attempt to
identify the space group.
If you specify Centric, rather than Acentric, you must enter only half of the symmetry operations
(as given in the International Tables ), related to any others by the center. The two sets or halves
of the operations related by the center will have opposite signs on the x, y and z coordinates. The
Centric choice implies that the origin of coordinates is on a center of inversion. If the space group
is actually centric, but the origin is not on a center, select Acentric and enter all the operations.
Note that for a transformation the atoms can be shifted (Pre-symmetry translations) in the
Tranformation Parameters dialog, to place the origin either on or off an inversion center.
The Bravais lattice type is in most cases the capital letter which begins the space-group symbol.
However, CRYSCON uses a somewhat different convention from the standard for trigonal
crystals: if you are using hexagonal axes for a rhombohedral crystal (whose standard space group
symbol will always begin with "R"), enter "R" - if you are using the primitive rhombohedral
axes, enter "P".
In the Operations group, you must enter all the "symmetry operations" for the most general
position in the structure. Click on the Add Line button to add a line, Delete to remove one. Note
that there should be only one operation per line. Enter or edit the line in the edit box to the right of
the list.

2.2.7

Diffraction Menu

You can do Powder diffraction, either as a diagram or a listing, or a Precession pattern.
The Font item in this menu will set the font for the legends in the diagrams as well as the lettering
for the indices in the powder diagram.
The font for the powder listing, shown in a Text Window, is set in the Window Menu of the the
Text Window.

2.2.7.1 Powder Diffraction
Dialog Box: Powder Diffraction [ Diffraction Menu ]
You can compute the pattern or list for either original (Old) or transformed (New) atoms and unit
cell.
If you select a List, the list will appear in a Text window (see Types of Windows). There will be
a line in the listing for each crystal form, or symmetry-unique set of reflections (with center of
inversion assumed). If there is more than one wavelength, the 2-theta and relative intensity will be
listed for each in that line.
If you select a Graph, you may show either Bars or a Curve - the curve will use Gaussian lines
with the selected full width at half maximum (FWHM). For a curve, the location of individual
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reflections will be shown as a short bar underneath the curve.
The Line width pertains to the width of all lines or "pen strokes" in the graph, not the width of
each spectral peak (FWHM).
If the Vertical scale factor or magnification is 1.0, the strongest peak will just fill the plot area.
If you want to see more detail in the weaker reflections, this factor can be increased and the
stronger reflections will be truncated.
If the atom records include temperature factors, they will be used. If an atom has no temperature
factor, the B isotropic value in the Default temperature factor box will be used. No absorption
or extinction corrections are applied.
Scattering factors used by default are those for neutral atoms from Volume 4 of the International
Tables (1974) edition. Atom type numbers must be atomic numbers, or must correlate with the
order of the entries in the SCATFAC.DAT file. This file may be edited to supply different
scattering factors (see Files Used by CRYSCON). Type numbers are taken modulo 100, that is
6, 106, 206 etc. all indicate carbon. By default number 99 is deuterium (symbol D) and 98 is
tritium (symbol T).
There are five options for wavelength; averaged K(alpha); separate K(alpha)1 and K(alpha)2;
averaged K(alpha) and (separate) K(beta); a single Specified X-ray wavelength; and Neutron wavelength. For the first three options, the X-ray tube target element must be selected in the
Radiation combo box. When two wavelengths are calculated, the bars indicating the second
(K(alpha)2 or K(beta)) are shown in red on the screen and in color output, and as a dotted line in
black-and-white output.
In the case of K(alpha) and K(beta) the relative intensity of K(beta) must be specified. For
unfiltered radiation this is in the neighborhood of 0.2. Of course it will be smaller for filtered
radiation.
This option gives only a semi-quantitative calculation of powder intensity, intended for purposes
of identification. For somewhat more elaborate options, including the ability to show multiple
species, try the program Powder Cell. For highly quantitative reproduction of powder patterns,
there are now many Rietveld programs available (see Import and Export files ).
The results of the Graph option are shown in a graphics windows (see Types of Windows), and
when this window is active, the file menu allows graphics Print and saving Metafiles. There is a
different window for the Old structure and the New structure.
For this option to work properly the space-group symbol entered either in the
Space Group from Table or Custom Symmetry option must be valid for a standard setting. If it is
not, it should be possible to transform to a valid setting. For example, the space group C-1 is
sometimes used. It is possible firstly to transform to the primitive cell (use the standard matrix C>P). However, this would change the indices of the X-ray reflections. Alternatively, the
transformation could be from C-1 to P-1 with the same cell. The h+k odd reflections will have
zero intensity, but the other reflections will be indexed as for the original cell.
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If the Index graph box is checked, the indices will be written above each line. The indices are
displaced somewhat in a vertical direction if they are close together, but to index complex spectra
it may be necessary to expand the scale using the 2-theta minimum and maximum settings. The
font for the indices is 0.8 times as large as the font for the legends. This font is set in the
Window Menu, or the Diffraction Menu of the Control Window.
The 2-theta, d-spacing and intensity (on a scale of 0 to 100 for the strongest peak) for the point of
the cursor are written at the bottom of the window.

2.2.7.2 Precession Pattern
Dialog Box: Precession Pattern [ Diffraction Menu ]
You can select either the original (Old) or transformed (New) atoms.
The Precession angle (mu) and Crystal-Film distance should match those of the real film to
which comparison is to be made. The Precession angle determines the extent of the pattern in
reciprocal space. If the Fixed Scale option (rather than Fit in Window) is selected, the pattern
will be in true scale. This can be altered with the Factor, which is 1.0 by default.
The part of the reciprocal lattice shown is determined by the Horizontal axis, the Other axis and
the Level. For example, for a 0kl pattern with b* horizontal, the Horizontal axis is b*, the Other
axis is c*, and the Level is 0.
Reflections are shown as squares whose area is proportional to the calculated relative intensity.
The intensities are normalized based on the number of electrons in the unit cell ( intensity of
reflection 000) and the smallest reciprocal lattice spacing in this net. The Intensity factor scales
the edge length, not area, of the squares (thus it really applies to the structure factor).
If an atom has no temperature factor, the B(iso) value in the Default temperature factor edit box
will be used. Extinction and absorption are not considered.
Scattering factors used by default are those for neutral atoms from Volume 4 of the International
Tables (1974) edition. Atom type numbers must be atomic numbers, or must correlate with the
order of the entries in the SCATFAC.DAT file. This file may be edited to supply different
scattering factors (see Files Used by CRYSCON). Type numbers are taken modulo 100, that is
6, 106, 206 etc. all indicate carbon. By default number 99 is deuterium (symbol D) and 98 is
tritium (symbol T).
If the Show grid box is checked, the reciprocal lattice will be shown as a grid in red on the screen
and color output, or as dotted lines in black-and-white output.
The results of this option are shown in a graphics windows (see Types of Windows), and when
this window is active, the file menu allows graphics Print and saving Metafiles. There is a
different window for the Old structure and the New structure.
For this option to work properly the space-group symbol entered either in the
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Space Group from Table or Custom Symmetry option must be valid for a standard setting. If it is
not, it should be possible to transform to a valid setting. For example, the space group C-1 is
sometimes used. It is possible firstly to transform to the primitive cell (use the standard matrix C>P). However, this would change the a and b reciprocal axes and the indices of the X-ray
reflections. Alternatively, the transformation could be from C-1 to P-1 with no change in unit cell.
The h+k odd reflections would be calculated and have zero intensity, but the other reflections will
be indexed as for the original cell.
If the Show extinctions box is checked, systematically absent reflections are marked with a small
circle, in red in color display and output.
Clicking on a reflection will bring up an alert box showing the indices, the d-spacing, the structure
factor (|F|), the intensity (I) and the Lorentz-polarization factor.
The font for legends is set in the Window Menu, or the Diffraction Menu of the Control Window.

2.2.8

Window Menu

The Window menu lists all the possible windows in CRYSCON - those which do not
actually exist are greyed out. Select a window to make it active, or bring it to the front.
When a Text window or either the Powder or Precession graphics window is active, the
first item in the menu is a Font selector. In the Text window, this acts on the entire text
in the window and the font applies to all Text windows. The font for the powder and
precession windows applies to both windows and to all text, except that the index
lettering in the Powder window is 0.8 times the size of the lettering for legends.

2.2.9

Help Menu

The Help menu offers the following commands, which provide you assistance with this
application:
CRYSCON Help Topics. This brings up the Help system. Use the Content, Index or
Find tabs to locate information on a particular topic.
About. This gives the version number of CRYSCON. For Macintosh, the About dialog
is either in the Apple menu (OS 8/9) or the Application menu (OS X).
2.2.10 Transformation Parameters
Dialog Box: TransformationParameters [ Control Window ]
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The structure which is input and listed in the Control Window is referred to as the Old or original
structure, and that derived from it is referred to as the New or transformed structure.
Click on the Symmetry button if the symmetry of the New crystal is to be different from the Old
symmetry. The default symmetry is the same as the Old. The symmetry specified here pertains to
the New orientation, not the Old, i.e., CRYSCON does not transform symmetry, so you must
supply the correct symbol or operations for the transformed unit cell. The symbols for different
orientations are listed in the International Tables Vol. 1 (1952) Table 6.2, and in the file
HALL.DAT - these symbols all appear in the list box in the Space Group Symmetry dialog.
Three types of transformation can be carried out.
1. Translation only simply adds the Pre-symmetry translations to the input atoms (Old or
original atoms) and does nothing else.
2. Input atoms only applies pre- and post-matrix translations and the translation matrix, but does
not try to fill out the unit cell for either the old or new setting. The number of New symmetryunique atoms will be the same as that of the Old input atoms. This is the only option which will
transform anisotropic temperature factors. This option may be used for simple reorientation
involving interchange of axes, and other transformations which do not involve a change of
symmetry or primitive unit-cell volume. It can be used for primitive to non-primitive
transformations and vice-versa, and transformations among different non-primitive Bravais cells.
Again, the correct symmetry for the New orientation must be supplied.
3. Full unit cells will transform all atoms in the Old unit cell to those in the New unit cell,
generating new atoms when necessary (supercell or decrease of symmetry) and averaging atomic
position when that is necessary (subcell or increase of symmetry). Anisotropic temperature
factors are not transformed - they are converted to isotropic. Vectors are transformed, although if
the symmetry is changed the new vectors are not guaranteed to be consistent with the new
symmetry.
The Tolerance is used to decide if atoms are coincident, and their positions should be averaged (if
the unit cell is decreased in volume, or the symmetry is increased). The tolerance in Angstroms is
converted to fractional coordinates on x, y and z, and applied to each atomic coordinate in turn.
That is, atoms are considered to be coincident if they fall within a unit-cell shaped box with edges
of length equal to the tolerance.
Use symmetry on vectors. If this box is checked, vectors (such as magnetic spin vectors) will be
operated on by the symmetry elements. If not, the atoms generated from each input atom will all
have the same vector as that input atom. Note that CRYSCON, unlike ATOMS, does not apply
Shubnikov symmetry.
The Standard matrices combo box will supply matrices for some common unit-cell
transformations. These matrices should all preserve the chirality or "hand" of the structure - other
combinations of signs on the coefficients are possible, particularly for the last five matrices for
simple interchange of axes.
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The parameters specified on the left side of the Tranformation Parameters dialog, going
downward in the dialog, correspond to the operations successively carried out by CRYSCON see General Procedure for more detail. After setting and verifying all parameters, click on the
Transform button, and the results appear in a new text window (see Types of Windows).
First, Pre-symmetry translations may be applied to the input atom coordinates. If the origin for
your atomic coordinates does not correspond to that of the standard symmetry specified for the
Old crystal, corrections must be made here.
---Translation only (origin shift) option
Nothing beyond Pre-symmetry translations is done – the remainder of the parameters are
ignored.
---Input atoms only option.
The Pre-matrix translations are applied to the Old input atoms, they are transformed with the
matrix, and the Post-matrix translations are applied. (Pre-symmetry translations are not used).
---Full unit cells option
CRYSCON now generates all the atoms in the Old unit cell. If the origin of the New unit cell
differs from that of the Old, with respect to the common symmetry elements, you must make
corrections in either the Pre-matrix translations or Post-matrix translations edit boxes. Such
differences among sub/supergroups are common, and it may be necessary to study the diagrams
and coordinates in the International Tables to get these translations. CRYSCON transforms the
vectors on the input atoms with the symmetry matrices. In the case of special positions, the vector
is taken from the first atom generated for that position. For subsequent atoms generated for that
position, the new vector is compared and a warning message issued if the two vectors are not the
same.
The transformation matrix is in the nine edit boxes. Some common standard transformation
matrices may be selected in the Standard matrices combo box to the right. The upper three
coefficients (first line) of the matrix give the New a-axis in terms of the old a, b and c axes.
Likewise the second and third lines specify the new b- and c-axes.
CRYSCON now transforms the coordinates according to the matrix supplied, adding additional
atoms by translation if necessary, or averaging atomic positions when necessary. The Tolerance
is used to decide when atomic positions are "coincident", and must be averaged. The tolerance
should be large enough to avoid having quasi-superimposed atoms in the result, but of course it
must be less than the smallest bond length in the structure. Setting this may take some trial and
error. A value of 0.4-0.5 seems to be large enough for even rather extreme cases of atomic shifts
in sub/supercells and sub/supergroups.
CRYSCON does not attempt to average vectors on coincident atoms; it takes the vector from the
first-generated atom and issues a warning message if vectors on subsequent coincident atoms are
not the same.
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Post-matrix translations may be applied here if the standard origin for the New space group is
different from that of the Old space group. This is an alternative to the Pre-matrix translations it should not be necessary to use both.
CRYSCON now applies the New symmetry to eliminate symmetry-equivalentatoms. Again a
tolerance is applied to decide if atom positions are "coincident". This generates a standard set of
symmetry-unique atoms, or the "asymmetric unit". However, in many cases when generating a
subcell or increasing the symmetry the averaging process does not put the new atoms exactly on
special symmetry positions and the calculation must be repeated in part - see General Procedure.
The Clear button resets the transformation matrix to the identity matrix, and it also resets the
Symmetry to be the same as that of the Old structure.
The Transform HKL file button will read a file containing index data and transform the indices.

2.2.10.1Transform HKL File
Transform HKL File [ Transformation Parameters dialog ]
This option will read a file containing a list of X-ray (or other diffraction) reflections, or just a list
of crystal faces, and transform them to a new axial system or unit cell.
You will be asked to specify the input file, and the output file (which must be different).
The data to be transformed must be in a text or ASCII file with one hkl per line. The data must be
in fields separated by spaces.
The first three fields must be the hkl indices (integers). There may be as many as 8 additional
fields, containing alphabetical or numeric information (these are read as strings).
To reach this option, click on the Transform button in the Control Window. The only data which
is used in the Transformation Parameters dialog is the tranformation matrix. It is not necessary to
click the Transform button to transform indices.
It is possible to have invalid transformed indices. For example, if the a-axis is halved, the indices
(100) will be tranformed to (1/2,0,0). CRYSCON will attempt to clear such fractional indices,
for example changing (1/2,0,0) to (1,0,0) and (1/2,1,0) to (1,2,0). Note that such changed indices
will be valid for morphology, but not necessarily for diffraction. If one of the extra fields in the
file (not indices) is the d-spacing (or central distance derived therefrom) it will not be changed and
thus some values may not correspond to the new indices if fractions are cleared.
The transformed data will be written line-by-line to the output file in the same order as in the input
file, but column formatting will not be preserved - the fields will be separated by a single space.
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Text Windows

When a text window is active, the menu bar contains a File Menu, for saving and printing the
contents, and a standard Edit Menu for editing the contents.
To return to the main menu bar, click on the Control Window (see Types of Windows), or use the
Window menu.
The Transform button in the Tranformation Parameters dialog lists the transformed atom
parameters and other data to a separate Text window. The Listing option in the
Powder Diffraction dialog ( File Menu) lists the data to a Text window, as does the
Bond Lengths and Angles dialog (called from the Control Window). Each window actually
displays the contents of a file, called respectively LIST.DAT and BONDS.DAT. These files are
written over again each time the respective option is called, so if they are to be preserved they
should be saved with the Save As command in the File Menu, using a different name.

2.4

Powder Diffractogram Window

This is a graphics window which appears as the result of the Powder Diffraction dialog (Graph
option) in the Diffraction Menu. It may show either the old or original atoms, or the new or
transormed atoms.
To return to the the Control Window if it is not visible, use the Window Menu.
File Menu. In addition to the standard Save, this has options for printing and graphics file output.
Window Menu. To set the font (for all diffractogram windows) and switch between windows.

2.4.1

File Menu (Diffraction Graphics)

The options here for graphics output (Print, PostScript, Raster, Metafile or PICT) are for
Powder or Precession graphics only.

2.4.1.1 Print Graphics
Dialog Box: Print Graphics Image [ File Menu (Powder) or File Menu (Precession) ]
If the Standard printer dialog on OK box is checked, the Print dialog supplied by the operating
system or the printer driver comes up after you click OK. Use that dialog to set the number of
copies, the orientation (Portrait/Landscape) or the resolution.
Color output gives essentially the same image as on the screen, with the bars for a second
wavelength in the Powder pattern, and the reciprocal-lattice grid in the Precession pattern being in
red. If the Color box is unchecked, these lines are shown dotted. If you have a color printer, you
may need to make a choice between color and black-and-white printing in one of the printer
dialogs as well as with the Color printing checkbox in this dialog. This choice may be an option
in the standard printer dialog above, or you may need to set it in the Print Setup option in the File
menu.
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See Frames for details of the frame and frame units.

2.4.1.2 Page Settings
This allows setting of the paper type or size, the standard orientation (portrait or
landscape) and the paper margins. Margins will only be used in Text Windows.
For Macintosh, margins are set in Page Margins.
2.4.1.3 Page Margins
-----Macintosh only---This dialog sets the margins for
size and orientation.

Text Windows. Use the Page Setup dialog to choose page

2.4.1.4 PostScript Output
Dialog Box: Direct Postscript Output [ File menu]
---- Windows only ----

This option can be used to write Encapsulated Postscript (EPS) files for transmission of
graphics to other software, as well as for direct output to a Postscript printer. This direct
output is generally superior to, as well as faster than, the output from the normal
Print Graphics command in the File menu if your printer is PostScript. The Destination
option sends output either directly to a printer or to a file in standard EPS (Encapsulated
Postscript V3.0) format.
Screen Preview.
Most word-processing and publishing software cannot display an EPS file on the screen
unless the file has a special bitmap attached, called the screen preview. This is actually a
sub-file in the TIFF format. The pixel depth of this file can be set in the
PostScript Settings dialog (Settings button). The pixel depth of the preview is set to that
of the screen, and the pattern series is set to fine (see Raster Files ).
---- Macintosh only ----

This option can only be used to write Encapsulated Postscript (EPS) files for transmission
of graphics to other software. For direct output to a Postscript printer, use the Print
option.
Screen Preview .
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Most word-processing and publishing software cannot display an EPS file on the screen
unless the file has a special attachment, called the screen preview. This is actually a PICT
in the resource fork of the file.
---- End Windows/Macintosh only ----

Settings button (PostScript Settings dialog). On or before first using the Direct
PostScript Output command, you should set or verify the settings in this dialog,
especially the port to which the printer is attached.
Fonts in PostScript output . Depending on your system configuration (Windows or
Macintosh, printer type and driver), the PostScript fonts supported by a PostScript
printer may or may not appear in the dialog for selecting fonts which may be called from
the xxxx dialogs. Furthermore, you may want to write EPS files for a printer which is not
even connected to your computer. These dialogs thus have an option to specify a
character string for the PostScript font. This string specifies the typeface, and includes the
weight (normal, bold) and other attributes (italic or oblique), but does not include the size
- the size is specified in the font dialog. There are certain standard PostScript typefaces
which are present on most PostScript printers.
See Frames for details of the frame and frame units.

2.4.1.5 PostScript Settings
Dialog Box: PostScript Settings [ Direct Postscript Output Dialog]
The page size, page margins and dots per inch/centimeter should be determined by the
actual printer used for final output; if these are not correct, the drawing may not be scaled
and/or placed on the page correctly.
Preview Color. If you select a screen preview (TIFF bitmap or PICT sub-file) in the
Direct PostScript Output dialog, and if color output is selected, you can specify either a
color or black-and-white bitmap. The Screen option uses the color depth of the the
current screen display. Black-and-white PostScript output always uses a 1-bit or blackand-white screen preview.
---- Windows only ----

If you are using direct output to a printer you must select the Port; this will be either
"LPTn" or "COMn". Also, if you are using a serial port for the printer, you must set or
verify the data transmission parameters, such as baud, parity, etc., even if the port
currently shown is the correct one. This is done in the Ports item of the Windows
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Control Panel (not in CRYSCON).
2.4.1.6 Raster Files
Dialog Box: Raster (Bitmap) Files [ File menu]
--Windows Only ----------

This command can write files in four different formats (File type): Windows deviceindependent format (.BMP); PC-Paintbrush (.PCX); Tag-image-format (.TIF); and
Portable Network Graphics (.PNG) files.
--Macintosh only---------

This command can write files in the Portable Network Graphics (.PNG) format. The
PICT/Clipboard option (File menu) can also write raster or bitmap files, in the PICT
format.
--End Windows/Macintosh only----

See Selection of File Format below for information on choosing the format.
The drawing may be either black and white or color. If black and white, the pixel size is
1-bit. For color files the pixel size may in some cases be selected. In Windows, 16-bit is
only available for .bmp files. In Macintosh, 8-bit (256-color) is only available if the
screen is currently set at this color depth.
If the Compress box is checked, .TIF files are compressed with run-length encoding,
which is one of the required formats under the TIFF 6.0 standard. However, some
applications may not support this type of compression, or may reject .TIF files for other
reasons. Also, if the Compress box is checked, 4- and 8-bit .BMP files are compressed.
1-bit and 24- bit .BMP files are never compressed. Owing to a Windows system bug,
compression of 4-bit .BMP files may not work when banding is used (see below). .PCX
files are always compressed. with their own format. 24-bit .PCX files can compress well,
whereas 24-bit .TIF files are only partially compressed (and then only if there are large
areas of black, white or grey), and 24-bit .BMP files are not compressed at all. PNG
files also are always compressed.
See Frames for details of the frame and frame units.
Maximum memory. Windows and Macintosh both use virtual memory , which means
that they pretend that a hard disk can be used in place of actual hardware memory chips.
For some applications this is useful, but when writing raster files it usually results a form
of lingering death involving "disk thrashing", or constant reading and writing of data to
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the hard disk.
CRYSCON is capable of imaging and writing raster files in segments or bands to avoid
this problem. This requires repeating the entire drawing process for each band, but this
usually is much faster than the reading/writing to disk involved in using virtual memory.
To do this requires knowing how much actual chip memory is available. Unfortunately,
at present Windows does not provide this information in a way that can be used for both
16- (standard Windows 3.1) and 32-bit (Windows 95/98/NT/XP) systems. Thus the user
may need to determine this by trial and error using the Maximum memory parameter.
When the Maximum memory parameter is set to zero, CRYSCON will simply ask the
system for a block of memory large enough to image the entire drawing at once. This
amount of memory is printed out in the dialog which appears after starting the raster
imaging: "nnnn bytes required, mmmm bytes available - will require 1 bands". If this
amount of memory is greater than the amount of chip memory available, Windows will
use virtual memory, which is typically manifested by constant running of the hard disk for
long periods (disk thrashing). If you change the Maximum memory to some amount
smaller than nnnn (say half), CRYSCON will only request this amount of memory from
the system, and virtual memory may not come into play. A Maximum memory setting
should be good for a given session, regardless of the size of the raster file; larger files will
use more bands. However, the amount of memory available may depend on whether
other applications are active.
The amount of virtual memory is determined by the available space on the hard disk. If
this is insufficient, CRYSCON will automatically use bands, but since virtual memory is
being used, it may still be advantageous to use a Maximum memory value which will
increase the number of bands.
Selection of File Format. The choice of format depends first of all on what formats are
supported by the target software (paint program; publishing program; etc.). Beyond this
the first choice should be PNG, second choice PCX, and then PICT, TIF or BMP
depending of what is supported and how much memory or disk space is available.
As of 1997, the preferred graphics file types for the internet were GIF and JPEG.
However, GIF uses the LZW compression scheme copyrighted by Unisys Corp., which in
principle charges a license fee for every application using it. JPEG files are compact but
involve losses and degradation of the image and are thus not suitable for CRYSCON
files.
The PNG format is intended to be a replacement for GIF, and in fact is superior to most
other formats, being lossless and giving very good compression for the type of images
generated by CRYSCON. Essentially all major software vendors have subscribed to the
PNG convention and releases from 1998 onward should support it.
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Most TIF files also use LZW compression, but CRYSCON does not use this type of
compression because of the copyright problem. The run-length-encoding which
CRYSCON does use is supposed to be supported by all TIF readers, but in fact some do
not support it, and this algorithm does not work well for 24-bit (RGB) images.
PICT bitmap files on the Macintosh are compressed by the system software and the
algorithm may vary. PNG files are usually smaller.
There are dozens of raster graphics formats and it will never be possible for CRYSCON
to support all of them. CRYSCON users who work with raster files should consider
investing in a conversion program - there are many such programs which are not
expensive. The PNG home page (www.cdrom.com/pub/pnp) has links to many
shareware and conventional commercial conversion packages.
2.4.1.7 Metafiles
Dialog Box: Metafiles [ File Menu ]
---- Windows Only ----------

Windows metafiles are basically vector images (but including fills) that can be rescaled without
necessarily losing resolution. They record the drawing commands that are used for the screen or
standard printer output, but the result may depend on the software or device for which they are
intended. You can write .WMF files or send the image to the clipboard.
To prevent loss of resolution, CRYSCON writes of metafiles with a standard scaling of 2540 dots
or pixels per inch (1000/cm). For 16-bit metafiles (.WMF), this means that the size cannot
exceed 12.9 inches or 32.7 cm. (that is 32767 dots, the maximum capacity of unsigned 2-byte
integers). If you enter larger values for the frame, CRYSCON will automatically halve both
values (with your permission).
See Frames for details of the frame and frame units.

2.4.1.8 PICT/Clipboard
Dialog Box: Clipboard/PICT [ File menu]
------ Macintosh Only ----------

Note that this type of output may be referred to elsewhere as Metafile output. This
option can write images either to the Clipboard or to PICT files, in either of two formats:
(a) a rescalable 2-dimensionalPicture or metafile, or (b) a raster image or bitmap.
Macintosh Pictures, as used here, are images containing lines or vectors and fills of
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regions defined by lines, that can be rescaled without necessarily losing resolution. They
record the drawing commands that are used for the screen or standard printer output, but
the result may depend on the software or device in which they are used.
Bitmaps or raster images record every pixel, so they are not susceptible to undesirable
modification by other software. Although most "painting" software can resize bitmaps,
this usually causes a loss of quality, so it is best to save a bitmap in exactly the desired
size. Note that you can also save bitmaps in the PNG raster format (File menu), which is
superior is some respects to PICT files.
If color output is selected, you can choose either 16- or 32-bit color depth - 8-bit (256color) files cannot be written.
You can select the nominal dots per inch/centimeter, but note that programs which read
the file may ignore this and show the image at 72 dots per inch.
See Frames for details of the frame and frame units.
2.5

Precession Pattern Window

This is a graphics window which appears as the result of the Precession Pattern dialog (Graph
option) in the Diffraction Menu. It may show either the old/original atoms, or the new/transormed
atoms.
To return to the the Control Window if it is not visible, use the Window Menu.
File Menu. In addition to the standard Save, this has options for printing and graphics file output.
Window Menu. To set the font (for all diffractogram windows) and switch between windows.

3

Reference
Topics of general interest.
Atom Parameter Files (Free-Form)
ATOMS and VIBRATZ files
Files used by CRYSCON
Frames
Samples
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Standard PostScript Type Faces

3.1

Atom Parameter Files (Free-Form or .inp)

This type of ASCII or text file may be used to read in atomic coordinates alone, or to supply
complete structure information. Listings of atomic coordinates from almost any source can be
used as the basis of a free-form file.
CRYSCON will also export this type of file, which can be read into ATOMS, SHAPE or
VIBRATZ (Shape Software).
All or part of the parameters for each input atom, namely label, fractional coordinates, type,
radius and display colors and pattern numbers, can be read in. You can also supply default values
for some parameters, so that the parameters neither need to be present on every line of the file, nor
need to supplied through the dialog.
Except for the TITL line, keywords and actual values to be read in should be separated by spaces
or commas, and there should be no spaces within keywords or values. There is no need for
alignment by column, except that keywords should start in the first column.
The input file may contain two overall types of lines; General and crystallographic information
lines; and actual data or atomic parameter lines .
General and crystallographic information lines. These lines should all precede the atomic
parameter lines. Each line consists of a keyword followed by one or more values or character
constants. The keyword should start in the first column and be followed by at least one space
before the actual values. Where more than one value is called for, they are separated by spaces.
All of these lines are optional - when a free-form file is used for import (File menu), if any lines
are absent, default values will be supplied.
TITL line. Up to 76 characters (may contain spaces).
CELL line. The unit-cell lengths in Angstroms and the interaxial angles in degrees (6 floatingpoint values). If the atomic coordinates are Cartesian, the axes should be 1.0 and the angles 90.0.
SPGP line. The Hermann-Maughin or standard International symbol for the space group. There
should be no spaces in the symbol, although there may be underscores (which are ignored when
the symbol is interpreted.
HALL line. The Hall symbol for the space group. There should be no spaces in the symbol,
although there may be underscores (which are ignored when the symbol is interpreted. If this line
comes after the SPGP line (or that line is absent), the Hall symbol will be used in the
Space Group Symmetry option.
SYMM lines. These give symmetry operators in "xyz" form, that is in the form in which the
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coordinates of the general position are listed in the International Tables for X-Ray
Crystallography. Fractions must be given as integers separated by a slash ("1/2", "2/3"), rather
than decimals ("0.5", "0.333"). The x, y and z positions must be separated by commas and there
should be no spaces in the operator. There should be one line for each operator. If the space
group is centrosymmetric, only half the operators need be given, if the origin is on a center of
inversion. If the origin is not on a center, all operators must be given and the space group should
be denoted non-centric in the LATT line. If these lines come after the SPGP and HALL lines (if
the latter are present), the Custom Symmetry option will be used.
LATT line. This gives the Bravais lattice type (single capital character), followed by a space
and 0 if the space group is centrosymmetric or 1 if it is non-centric.
FACTOR line. A single (floating-point) factor which multiplies all the fractional or atomic
coordinates.
Atomic parameter lines :
The file should have all the information for each atom, except for temperature factors, on a single
line with a maximum of 80 characters per line, and the values must be in fields , which are set off
or delineated with either spaces or commas. There can be no spaces or commas within fields. The
names of fields are given in the following in capitals, but in the actual input they may be lower
case; all letters are converted to upper case when the line is read in.
DEFAULT lines supply values to the parameters, such as colors, which are not read in for each
atom. If default values are not entered in this way, default values are obtained from the separate
ELEMENTS file, using the chemical symbol of the atom which is assumed to be in the first two
characters of the atom label. See the further description of DEFAULT lines and the
ELEMENTS file below.
FIELDS lines. These lines set up the CRYSCON input parameters which are to be read from
the file, and the order in which they are to be read. . This is followed by the keywords giving the
order of the fields. The allowed keywords are as follows (INTEGER fields may not contain a
decimal point):
1) LAB - (6 characters maximum). Any label for the input atom may be used, but the label
normally begins with the chemical symbol for the element. The first two characters may be used to
determine default values for some of the parameters, as described below. The characters may be
upper or lower case. This is a required field.
2) COO - This actually denotes three floating-point fields giving the fractional atomic
coordinates. After input, the coordinates are multiplied by the number in the FACTOR line, if
this line is present. These are required fields.
3) TYP - This is the type which is used in locating bonds and polyhedra. INTEGER
Fields 4-9 are for use in ATOMS and are not used by CRYSCON, but if the data was originally
imported from ATOMS (.STR), they will be written in an Export file for re-introduction into
ATOMS.
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4) RAD - This is the radius used when the atom is plotted as a sphere. FLOATING-POINT
5) RMC - This is the color number for the atom rim or edge. INTEGER
6) FLC - This is the color number for the atom fill. INTEGER
7) RMP - This is the pattern number or gray shade used in black-and-white display or output.
INTEGER
8) FLP - This is the b/w pattern number for fills. INTEGER
9) PEN - This is the pen number used for atom outlines in pen plots. INTEGER
The following fields may be used by CRYSCON.
10) TFB - Temperature factors in B or bij (beta) form, types 0 (anisotropic) or 6 (isotropic) in
ORTEP. If this keyword is present, the temperature factor(s) are present on a second line for each
atom, in up to six fields The order is 11, 22, 33, 12, 13, 23. If the second value is absent or zero,
the temperature factor will be read as isotropic. Note that CRYSCON will save temperature
factors only if at least one atom has non-zero for the first value or b11.
11) TFU - Temperature factors in U or uij form, for anisotropic type 8 in ORTEP. Similar to
TFB. Isotropic U values will be given number 10, although this is not standard ORTEP.
12) VEC - Atomic vectors, e.g. for magnetic spins or vibrational displacements. If this keyword
is present, the vector coefficients are present on a second line, in four fields. The first three are
the relative components in the structure axes, and the fourth is the length. Vectors and
temperature factors may not both be present.
13) DUM - This designates a field (character, integer or floating-point) that exists in the input
data line, but should be ignored by CRYSCON.
Note that the actual atom data lines do not contain any keywords. The keywords in the FIELDS
lines set up the sequence of parameters in each data line.
An example FIELDS line:
FIELDS DUM LAB COO TYP RAD
Some corresponding data lines:
1 C1 0.1234 0.2345 0.3456 6 1.2
2 H2 0.4321 0.5432 0.6543 1 0.1
Here the first field, which is simply a sequence number, must be ignored by CRYSCON, and is
designated with a DUM.
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Here is an example of some lines copied from an (old) ATOMS .STR file (spinel):
FIELDS DUM LAB TYP COO RAD
1 MG1 12 .12500 .12500 .12500 .000
2 AL2 13 .50000 .50000 .50000 .000
3 O3

8 .26200 .26200 .26200 .000

There should normally be a FIELDS line at the beginning of the atomic parameter lines, but
additional FIELDS lines can be inserted at any point to redefine the fields. If there is no FIELDS
line, the fields are by default; LAB and COO.
In the actual data lines, fields denoted INTEGER above should not be more than 6 characters; the
COO and RAD fields (floating-point) should not be more than 20 characters.
DEFAULT line. This is used to set particular default values for fields other than LAB or COO.
DEFAULT must be the first 7 characters. Then the default values are indicated with the name of
the field connected with an equals sign (with no intervening spaces) to an appropriate value.
Example default line:
DEFAULT TYP=1 RAD=0.95 FLC=15
There are twelve possible input fields for each input atom, or each line in the file, plus the
placeholder DUM field. The LAB and COO fields are required for each atom and must be read in
from the file; the other fields are optional. If the latest FIELDS line does not define a field for a
particular parameter, then the value of the missing parameter is determined by reading the first
two characters of the label (LAB field) and trying to identify the element. You can turn off
defaults, thereby accepting the values on the input atom line, with a line containing the word
DEFAULT and no other keywords.

3.2

ATOMS and VIBRATZ files

CRYSCON users may want to use or transform the data in the Shape Software programs
ATOMS, for drawing crystal structures, and VIBRATZ, for normal-coordinate calculations. The
data files for both these contain far more data than CRYSCON requires, and while Crycon will
Import either type of data file, it will not export either type. The procedure for taking data from
these programs, using it or transforming it, and returning it to these programs is as follows.
1) In CRYSCON, directly Import the ATOMS (.STR) or VIBRATZ (.VBR) files. All data
required by CRYSCON should be in these files. Of course both of these programs handle
molecules or polymers as well as crystals, and CRYSCON deals only with crystals.
2) If the objective is to simulate Powder or Precession patterns or diffraction listings, no
transformation is required - just select the desired option from the Diffraction Menu.
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3) To transform the data, follow the procedure outlined in General Procedure.
4) To return the transformed data to ATOMS or VIBRATZ, select Export in the File menu, and
write a Free-form (.INP) file.
5) ATOMS or VIBRATZ can now import the .INP file through the Import options in their File
menus. In the case of ATOMS, it is also possible to read the data into an existing file (for
example the original data file) through the Input Atoms dialog (Input menu). This has the
advantage that all pre-existing specifications, including bonds and polyhedra, are preserved.
When an ATOMS file is read into CRYSCON, the data on color and atomic radius are preserved,
although they are not used by CRYSCON. They are written out in the .INP export file and will
be read back into ATOMS (see Atom Parameter Files).
The program SHAPE will also read .INP files, so can use transformed data from CRYSCON.
Transformed {linkN

3.3

Files Used by CRYSCON

CRYSCON recognizes two file folders or directories; the home directory and the data directory.
The home directory is the one containing the CRYSCON program file or application. This
directory must also contain the following data and setup files:
SCRPTR This is the setup or preferences file for CRYSCON. If it is damaged or lost another
will be created, with default values.
HALL.DAT
CIFDIC.SHT

This is the file containing space-group data.
This is a required dictionary file for importing CIF files.

SCATFAC.DAT This file contains the X-ray scattering factor data for neutral atoms in the
exponential form as given in the International Tables , Vol. 4. This file may be modified to use
other scattering factors (e.g. for ionized atoms). The scattering factors are keyed by sequence
number as read from this file to the atom type. There is a maximum of 100 scattering factors.
Type numbers are taken modulo 100, that is 6, 106, 206 etc. all indicate carbon. By default
number 99 is deuterium (symbol D) and 98 is tritium (symbol T). For neutron diffraction
involving isotopes it is a simple matter to copy the line for the element in question into a position
which is unlikely to be used, such as numbers 93 to 97, and change the neutron scattering length,
which is the last coefficient (the first 9 coefficients give the X-ray form factor).
The following files are always written to the home directory.
BONDS1.CCD, BONDS2.CCD These files contain the results of the Bond Lengths and
Angles command (Control Window).
POWDER1.CCD, POWDER2.CCD These files contain the listing of d-spacings, etc. from the
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Powder Diffraction command (File Menu), Listing option.
The BONDSn.CCD and POWDERn.CCD files are rewritten every time you use the Bond
Lengths and Angles or Powder Diffraction (Listing) commands. Thus to save these results
permanently, use Save As (File Menu) to save them with a different name.
The data directory is the one containing the current data file. This directory is saved in the
SCRPTR file, and thus the Open command returns to it when you start up CRYSCON.
infile .CCD This is the output file from the Transform command (button) in the
Transformation Parameters dialog - here infile is the name of the CRYSCON data file (infile
.CCO). It contains a listing of the atoms in the original unit cell and the transformed unit cell, and
the transformed symmetry-unique (input) atoms. It is displayed in a Text window (see
Types of Windows).
infile.XXX Export files are given the appropriate default extension (.XXX), and are written by
default in the data directory, although you can write them with any extension. Changing the
directory in which the file is written resets the data directory.

3.4

Frames

Frames [ Print Graphics, Metafiles ]
With printed output, you have a choice of using the full page, or confining the output to a frame .
For Metafiles (File menu) output always goes to a frame.
If you are using the Fixed scale mode for a Precession or Powder pattern, the image is clipped to
the frame. Otherwise, the image is scaled to fit the frame.
In printed output, the frame can be positioned on the page; the offset gives the displacement of the
upper left corner of the frame from the upper left corner of the page.
You can choose the units for the size and offset of the window; either inches or centimeters.

3.5

Samples

All the examples are real minerals, and the tranformations are between non-equivalent but similar
structures, not just changes of axes. There are files transforming each structure in the set to the
other structure(s).
The transformations type is Full unit cells.
Marcasite(mc)-arsenopyrite(as). In addition to the substitution of As for one of the sulfurs in S2
groups, the cell and symmetry are different.
Columbite(co)-huebnerite(hb)-wodginite(wo). These oxides have the same basic structure,
differing in the pattern of cation substitution.
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Cubic boracite(boc)-orthorhombic boracite(boo). This is a high-low temperature transition.
The low-temperature orthorhombic form is ferroelectric and can take several orientations with
respect to the cubic high-temperature form. Some atomic displacements are quite large.

3.6

Standard PostScript TypeFaces

Standard PostScript Typefaces (Font Families)
The names of the fonts should be entered exactly as given, with no embedded spaces. If
your printer does not recognize a font string, it will probably default to Courier.
Times Roman Family
Standard:
Times-Roman
Slanted:
Times-Italic
Bold:
Times-Bold
Bold Slanted: Times-BoldItalic
Helvetica (Swiss) Family
Standard:
Slanted:
Bold:
Bold Slanted:

Helvetica
Helvetica-Oblique
Helvetica-Bold
Helvetica-BoldOblique

Courier Family (fixed pitch)
Standard:
Slanted:
Bold:
Bold Slanted:

Courier
Courier-Oblique
Courier-Bold
Courier-BoldOblique
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